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simple

VE A FR AR

1) b B 7 ik 5 1F 9 Western AH ]

3)
4)

5)

& REBRBEEIM (LysisBuffer) &

o R BRMAANT 27 E I RA W
> P& «Simple Western Buffer Compatibility.pdf»

< jim A\ Western F# % 9 i (Loading buffer)

i 33 BCA R & 0 2 & A f ik Z

S ORERWAEINGUL L, wmREEGFEMR (BRAE
A) , HEFELELIRE 2pg/ul, HMEE A W% 0.5 ug/ul

<> W FE B AR P4 SDS, % H Flo.1x Sample Buffer i B
» ProteinSimple $# fft10 x Sample Buffer, FE B H H 0 H & F

AR Bk A8 B JE A

> 10 x Sample Buffer & DL 84T iy, %5 ¥ 042-195

> R R A2 SDS (AnfEPBSE o R P A B ALEE) , A
T il1x Sample Buffer # B AR IEH E E#SDS 5 & A i 4 &

W R E Ja, o 7 4% FR A 2E- 80 °C ok 48 B 2| B B

— BT &

< f# F ProteinSimple £ fit 85 Antibody Diluent 2 # & J5 {¢ F|

< BV X Wes B iE ot iy Hutk, It 5 At B L F & i iR 28 E
http://www.proteinsimple.com/antibody/antibodies.html

S WREERAN—PAEREEEEE, 2UVULTUERYA S

(datasheet) E {73 Hy Western 3% /& & 10— 20 £, Bl Hufkin BH +

1 #1:1000, Wes | fl1:50 - 1:100 W) F B &

—

<> E 7l ProteinSimple £ Bty B & b —FH FHA R FHA, P
* (FEF 417 F043-524 89 Milk-free Antibody Diluent # F ) ,
& R 11T Y

> WREN - BEREFZULMBERIE, BZWNEE R ELEE
Wy LA N By 47, J ProteinSimple £ Bt ¢ Antibody Diluent 2
ik B A

> WREERN _RFAEREEEER, FEERMNABALFFIHK
#
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W £-Wes

SE R W IR E A RAE 18-24°C 2 18], BEAE 20-60% Z |5, WWRIR
F BERFKBEXK, BIAZHE. BRENKEMAEREE, EE
kBB R AE R

R AT IF Wes. ., Jig fn Compass 2 15 .

< R A KERE EWes, 28R NP

< R AR H % EWes, & & if Instrument > Connect

AT B AR o

< &< Instrument > Self-Test # 4T Wes #2 14F B 46, B jH K4 E E 10
a4

< HMBWEEFEFATIAT B4, UUH IR 78 7 09 5 4R 7]




proteingisliE

3. fmgE

1) ERAERN B WM RS ERHTRE
2) T H VASM-Woog4FiDM-001 % ], 48 52560 #y ELpR T 42

a) VERIKEFEIK, BHFRE 4 CHREANEWE R & (PS-SToi-
EZ-8%1DM-001) , ¥ H H ik ok Lk E ;

e ] e N
f»— . - ‘: ’ @ :

Anti-Rabbit Detection Module
Wes, Peggy Sue, Sally Sue
#1782 Exp: 31

EZ Sta, sl

nda

(407 agpg 12,,230'&".(‘”
S L

&

b) TH —4& %48 (Standard Pack1) |,

o) RAFEHLMEIRE T 05 EENH;
d) ELH DTT: HHE WA A EDTTHR, A sopul £&F XK,
RITHA 5

'y

e) Tt % 5x Master Mix (Ef Loading Buffer) : W% ¥4 i B ) &
Master Mix ¥ K, AN\ 20 uL DTT %k (b —F B th, 4n B A BAT
LR Bk, T LA ADTT) |, 20 pL 10x Sample Buffer (£ %
BRAEN) , RITHA;
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e #| Ladder (Bimarker, oF Efr i d) @« REECEZAET N AR
fLaddertp K, ArA20puL&EF K, BRITRAHT, RFMAEL
e

e, 4 A5 o -

> 1 NFLEE3uLBE S (e T Master Mixtly) , & T By ok % M Bt
AL, BN 1 MW E, BREFERERE Y, UT
y B AN FU AT AR

PR B B R R 5x Master | 0.1x Sample Buffer BARF
(pg/uL) (uL) Mix (L) (pL) (pL)

0.2 0.2 X 4.5]y 0.9 4.5—(0.2x 4.5/y)—0.9 | 4.5

1 1x 4.5/y 0.9 4.5—(1x 4.5/ y)— 0.9 4.5

> KT A 8 A R A 95°C R M 5 4

> TMEREWAEGERE, KA s o8, AH R RK TR
4, BEEBEN, mEkEER;

e —3i: — i Antibody Diluent 2 # % 5 i £ 7k L5 A 5

> BAFEOUHEEN—f, RELBELIKE 1241

dy Djj, ‘e " e
7} ‘

EER E T L
Tt %) % St : Lumino-S F Peroxide & B 200 uL, % i€ 4k 3% R4,
HAER LA
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&

Z,
M’f”@ﬁ?‘]é\g@.ﬁﬁ(ﬁjﬁ% %Eﬂ%ﬂﬁ%ﬂ'ﬂﬁ?ﬂﬁ@kﬁw\ﬁm'
| fmks R RARROR G, BUE AR, AT, XA
"ﬂT M o ERmaEmL S, DLk é@ BEIRNBAEAN
T iAo
A4T: A1 4 Ladder, spuL, HAFLAEH, A 3uL
B 47: Antibody Diluent 2 (%}MZM%%:;&) KA 10 L
C47: Ca #Antibody Diluent2, HEAIL A #HEH —F, K 0L
D 47: DaJyStreptavidin-HRP, H & FL 448 5 8§ — 30, AR 10 L
EAT: ki’é/& PRAR 15 pL
FAT:
B AL FATHN = K AT W & 48 n X\ 500 uL Wash Buffer (Wash Buffer %
HeERAEN)

N B

%

5 10 15 20

ABLLLLOCCCUOCOOUCCUOUCLIIL) || @Biotinylated Ladder, 5 pL; @Prepared Samples, 3 uL

@ Wes Antibody Diluent 2,10 pL

HE00000000000000000000000 @ wes Antibody Diluent 2, 10 uL; () Primary Antibody, 10 pL

@ streptavidin-HRP, 10 pL; () Secondary HRP Conjugate, 10 pL

() Luminol-Peroxide Mix, 15 pL

. Wash Buffer

. 500 pL/compartment

. 2.5 mL/row

For more consistent results, keep the lid on between

reagent additions and minimize bubble formation when
adding Wash Buffer to the troughs in the microplates.

1. Dispense reagents into the assay plate using the

Peel off immediately before volumes shown in the plate diagram.
placing in instrument 2. Centrifuge the plate for 5 minutes at 2500 rpm
(~1000 x g) at room temperature. Ensure liquid is fully

)

down in all wells.

= EET, WFJEAEZIR2500rpm (~10009) B 544
> ER! —EEmET

> EE!D BOIF A

> BROEHREFFHAILKRLANE



3)
4)

5)

6)
7)

proteinglalslfS

a bietechne brand

EARE

7 47 FF Compass for SW, 7 & i File > New Assay;

Siza - Compass for SW - oIEH

o Fle | Edt lnstument Window Help
. New Assay r Wes... [0 Assay ("J Run Summary G Analysis
Open Assay | peggySue.

vvvvv

eparation Matrix

Import Termplate
-oia
pALY P

A9 B O A WAL, K 2 OK Ak

> BARFHSHEEIRN GEE) @ New Wes Assay ]

< Western #{Assay Type i Size Koo st co

> RN _EATE W LT &L B % 4F Size QTetel rosin S0 | @ 12200 kDa || O1:
Range

S ARABE A AR N B A
Cartridge

B ab Wes |1 F# 4R X, FTHIT;
W EmE S, BT E M\ Wes,
> EE! FNEEEERNER, FTEEEEMRERY

proteinsimple

proteinsimple

.

el TRY, —FRERT, —FHEHE, ERTHAN
Wes;

-

- —

*I7T, ME s a2 1481k, & Start FF4EE4T, B
BN EEN T EF XN FHLE, BRAKRE: vJ —
% 1y ST R\Compass\Runs T 3£ 14 o



5. BATRAMEL &R

1) JF46iE4T 5, Compass 32 & s ¥ N\ Run Summary 5.1, 7871
52 16ty 25 TR Fu bt (]

Assay 4 T’j Run Summary f_' Analysis

Sample Sep E 1* 2% Detect  Results
(T Ty 0Ty I;I ) Py
& . . B8O t®H zH A =

10:18 5 10:23 B 11:13 EF 1119 BF 11:56 BF 1237 FF 1253 5

< JHieEAT R0 A I U E BB A AN T HE N ;

B separation . < IV Plot

pam

> RFFHERER, £RVE _REBEXRE
2) EWAERE, BT, FEaE R TREEF;
3) KKK M Compass B 1 F0 HL i o

> AR AE— B NI E R Wes, Wes 7 LA & Al
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6. ¥R A

1) WEA A
> MRS IFEA A RE R EAM R, FEERERERE;
> B ¥ NAssay B, fETemplate E R HEZ I W EHF O,
Name 35\ 4 #7, Attribute 3L N\ 2008 Z, ] DU ctrl+c Fo ctrl+v
FATILE FRE M, ¥ DUFI AL shift Fo ctrl 3% 22356 5 £ AN FLaEAT
7o, #Z 7 LA Excel & 4| kAL

@ Demo Wes 25 caps - Compass
File Edit Instrument Window Help

- Assay | (15 Run Summary £ Analysis
‘ Runs Demo Wes 25 caps ‘[ Protocol |y History T Notes| =g
Bl Layont x =g Add ~ Remove
Value
Separation Matrix
A
3 Stacking Matrix
o Sample
> 00000O000; 000000000 Separation Time (min) 0
E Sepaf
= x
" Matri, =
G
1 Antibs N
5 Prima ame:
E remplate oK Cancel - =
Edit
~

5 vV o
Luminol/Peroxide R EBlE S "LARGE Windows |

2) BMERHANS:

C RAEASEREBHEESTHEZ PR FIERRER, WRKTKA
WEEER, a¥HREameTEITH

> FARF4E N4 H 1kD, 29kD Fr 230kD X =N A K S

< # A\ RunSummary R, 7 Separation & FRE HE N2 H

SHEARENS;
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B Assay | ("5 Run Summary | £E% Analysis

E Separation . %< IV Plot

400D B
< W E Y32 Analysis £ 1, % % Standards > Single View > Graph,
BEF—REAECERALNSEMAEEFTEFH. K LN SEGraphE
AT IE H Std 1, Std 29 F7 Std 230

7] Demo Wes 25 caps - Compass
File Edit View Jastrument Window Help

= Standards | 2 Samples | H
[EE Experiment =8 mage | [ Lane

Sample  Primary Cyde Cap § 1 Cl:1
Ladder Ab dil.. 1 A 90 1 Std 1
Hela  ERK1.. 1 2 Az o
Hela  ERK1.. 1 3 A3 cE |
Hela  ERK1.. 1 4 M A Ladder
Hela ERK1.. 1 5 A5 et
Hela  ERK1.. 1 6 A6 cf|
Hela  ERK1.. 1 7 a7 cl| 2
Hela  ERK1.. 1 8 A8 cg u
Hela  ERK1.. 1 9 a0 ol =
Hela ERKT.. 1 0 A. C =
Hela  ERK1.. 1 1 A. C
Hela  ERK1.. 1 12 Al C Std 29 std 230
Hela  ERK1.. 1 13 A. C ]
Hela  ERK1.. 1 14 A, C
Hela  ERK1.. 1 15 An C
Hela  ERK1.. 1 16 A. C
Hela ERK1.. 1 17 A 300 350 400 450 300 550 800 630 700 750
Hela ERK1. 1 18 A. C Fesition

> wWRHIA R, FEHFHNE FEERAAEALEE, AF
& #% Force Standard & IE, W R K IF W4, T & Clear All ik &
BN E ;

@ Demo Wes 25 caps - Compass -
Fle Edit View Instrument Window Help

= standards | =% Samples || W22

ssay (5 Run Summary | g2 Analysis

[ Experiment = 5 (i Graph Image| [ Lane TEgl=-"=18
Sample  Primary Cycle Cap S 1 Cl:-3
Ladder Abdil. 1 1 M o 150 Std 29
Hela  ERKT.. 1 2 M 140
¥ Hela ERKI1.. 1 3 a3 3 130 |
Hela  ERKT.. 1 4 Ao 120 HeLa
Hela  ERKT.. 1 5 A5 Cf 110 L
Hela  ERK1.. 1 6 A6 ce| 100
Hela  ERKT.. 1 7oA o g 9
Hela ERK1.. 1 e ag ocg @ %°
Hela  ERK1.. 1 9 a9 g é ;Z
Hela  ERK1.. 1 10 A.cff =2 %
Hela  ERK1.. 1 1 A C :z
Hela ERKT .. 1 12 A C.
Hela  ERKi.. 1 13 AL C ZZ stg 1 stq 230
Hela  ERKi.. 1 14 AL C o )
Hela  ERK1.. 1 15 A, C . M Zoom Out /\_/%
e |1 16 A e e Cw o130
otn | ERKT_ |1 A o Posit  Standards. I EALF
Clear Al

Hels  ERK1.. 1 19 A. G55 peaie™ F Capilaries =0
Hela  ERKT.. 1 20 A G Copy- Crl+C
et | ErK— |1 3 m. ()| Samele  primary Cap Peak Position  Height - ~

S NI 1kD LR A A Y B R
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3) A#rLadder:
<> 4% Samples > Ladder, # # Ladder #y 6 /MI& (12kD, 40kD, 66kD,

116kD, 180kD#n230kD) o F &2 & E#H, IE% & EHW T Hr:

(7] Demo Wes 25 caps - Compass a
File Edit View Instrument Window Help

1= standards ‘||i| ]
—

EE Experiment = O[[k& Graph . B Image | [ Lane 1B Egv =

sample  Primary Cycle Cap 5 1 Cl:1
Ladder Abdil.. 1 1 A1 Cl
Hele ERRT— i oy Ldr 12 Ldr 40 Ldr 66 Ldr 116 Ldr 182d
Hela ERK1.. 1 ERNE I 8, 000,
Hela  ERK1.. 1 4 Mo
Hela  ERK1.. 1 5 A5 Cs 7. 000
Hela  ERK1.. 1 6 A6 Cf| S 6 000
Hela ERK1.. 1 7 a7 ol 2
Hela  ERK1.. 1 s a8 cf| E
Hela  ERK1.. 1 9 a0 cf 2 4000
Hela ERK1.. 1 10 A. C %
Hela ERKi.. 1 1 AL G| B 3000
Hela  ERK1.. 1 12 A. C. 2, 000
Hela  ERK1.. 1 13 A. C.
Hela  ERK1.. 1 14 A C o 02T
Hela  ERK1.. 1 15 A. C. o
Hela  ERK1.. 1 16 A. C.
Hela ERK1.. 1 17 A G B2 ° °e e woe
Hela  ERK1.. 1 1B AL C L @eey

< Wk Ladder T E X EH, N f Al fLadderRit&EoT &, 7
PA7E Edit > Analysis... > Standards > Ladder Capillary % T % A&,
None, 3t # {3 F 4 A itLadderit £4F &, MAKEHRE
WA N RN S E AT R

= | R P s—"

Analysis: Dema Wes 25 caps. - =

®

File | Edit | View Instrument '

aply Override: ider Casi -~
Cut e -
Copy Cirl+C
Paste Ctrl+V
£ X ¥ 3
Analysis... s
Preferences . e | =— ][ e

4) D
C RRERTBREATUEEFBEER;
<> ¥ EZEEdit > Analysis... >Images B 5 % < & B B A, 5] B A
E BB SINAE (SN 8B A M4 )

7] Analysis: Demo Wes 25 caps
type filter text Images
Advanced
Images Cycle Luminescence
Peak Fit
Peak Names All Exposure 1 30 seconds v
Standards

1 Exposure 1 30 seconds "
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1554 Graph Image] Lane}

Cl:11

20,000
Svstem Control ERK1
18,000
16, 000
14,000
12,000
10,000

8, 000

Chemiluninescence

&, 000
4, 000

2, 000

0

12 0 58
MW (kDal

3 peaks " ¥H Capillaries|

Sample Primary Cap Peak Name Position MW (kD... Height Area 9% Area  Widtl §/N Haseline
Hela ERK1 ... C1:11 1 Syste.. 26 26271 29037 13.8 1 1024 5741

Hela ERK1 .. Ci:11 3 237 388.5 6799 164 10.7 580.6

5) ﬁ?@‘%ﬂ@%%ﬂji
< #Edit > Analysis... >Peak Names E ik E ¥ E A 40T & (FER
#Wes - 55 kW 4T Bk €)
< Apply Toix B/ THr#fsk, RELKEAssay E @ a4 T — W 4
, XEoAMNNEFEEN, ETUKEENEEaSTEN
R 2T ZeEka—mnilt

| i i ~ = - -
ERK1 + control '
- T T T
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® Analysis: Demo Wes 25 caps = B
type filter text Peak Names f R
Advanced
Images Analysis Settings Analysis Settings: Protein
Peak Fit :
Peak Names Rroten MName MW Color Range (%) Control Show
Standards ERK1 46 - 10 O
syst.. 26 [ 10 O
Add Remave
Apply Settings
f’ﬁ y 1o Settings
LERK1 + contral )Protein
Add Remove
Caontrol
Reference Capillary Hela
Control Area 100000.0
Add Remove Standard Curve: | Define...

6)

R OK tRE X EIFBR Y . o P RE B WA T /2 H 20477 £ Graph

B, XEHEQE B F Capillaries, X B4 B G0 E G0 E&H X‘Ff;éi
(Area) , & LA Ctrl+A 4 Capillaries B 8y #E 2 ##% P,
2 | K i 7 Excel .

File Edit View Instrument Window Help

= Standards [ sampies | m (&)

/n\

Demo Wes 25

7)

& Lane #Aa‘%%ﬂﬂx@%@ Tu,mﬁﬁ View All 2 3%

®

File Edit View Instrument Window Help
e

[ Experiment |ViewA|I E:Graph rImage( Lane

‘ Sample

anary Cyc\e Cap s 1

8)

157 UL & & Single View, % 5 ) F Ctrl 4% 3%

EE Experiment = Eﬂ_ 155 Gra_% Imagew Lanew
Sample Primary Cycle Cap § 1 |

Ladder Abdil.. 1 1 Al 1 =
Hela ERK1.. 1 2 = = g
Hela ERK1.. 1 3 A3 CF = Sy==em
Hela  ERK1.. 1 4 M = = ==
Hela ERK1.. 1 5 AS [ X
Hela ERKT.. 1 6 A6 CE (7% poaks [@
Hela ERK1.. 1 7 AT CJ
Hela ERK1.. 1 8 AB CE —
Hela ERK1.. 1 g A9 cg||| Sample Primary Capillary ERK1 System C..
Hela ERK1.. 1 10 A.. C.Jl|| HeLa ERK1 ... C1:2 245410 42877
Hela ERK1.. 1 11 A.. c.|| HeLa ERK1 ... C1:3 230387 33728
Hela ERK1.. 1 12 A.. C.J|| Hela ERK1 ... C1:4 240275 36349
Hela ERK1.. 1 13 A.. C.Jl|| HeLa ERK1 ... C1:5 216383 36751
Hela ERK1.. 1 C.l|| HeLa ERK1. C1:6 200153 35438

¥

fPE 3N A S -
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File Edit View

2 Standards [ Samples | [ 2

Instrument Window Help

F Experiment m Graph | Image [ Lane
Sample  Primary Cyde Cap 5 1 e e e
Ladder Abdil.. 1 1Al W A
Hela ERK1.. 1 2 A2 Z|
Hela ERK1 .. 1 3 A3
Hela ERK1.. 1 4 Ad
Hela ERK1.. 1 5 A5
Hela ERK1.. 1 6 AB
Hela ERK1.. 1 7 AT
Hela ERK1.. 1 8 A8 Cg
Hela ERK1.. 1 9 A9 Cg
Hela  ERKT.. 1 10 A. Cd [repr—p—
Hela ERK1.. 1 1 AL C 40—
Hela ERK1.. 1 A. C.

9)

%+
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Contrast Adjustment... 7] b 8 % B 4% 3¢ th J ;

Assay Tj Run Summary EEE Analysis

@EEF| L =0

| Contrast Adjustment... i

IR A

IANNEFANN]

<> R

Ko bk E, 9 L A Edit>Analysis...>Lane

Contrast, 3%t #Fixed Levels, #; AWhite Level#rBlack Levelt{# .

@ Lo Analysis: 20165-10-21_15-47-51_Wes-25 Size-ly = =
File Edit ‘“iew Instrument Window Help type filter text Lane Contrast . . -
= Standards | = E Advanced
EH Experiment = O [ Graph Y Images
- Lane Contrast
Sarnple Prirnary Cycle Cap & 1 § Peak Fit
Biot. .. Blocki.. 1 1 Al C g Peak Mames White Lewvel 1
O buffer BAX1.. 1 2 A2 C o Standard
ERR andards
o BAY- T 1 ] a1 C 5 |’ Elack Level 1000
. \ — - \ R S T
10) & £ A ByEdit Labels, [ DL R/ E L7 89 X FARE
@® Demo Wes 25 caps - Compass - g

File Edit View Instrument Window Help

2 Standards | = Samples || M 35

[EE Experiment. = O | Graph | Image Lane
Sample  Primary Cycle Cap S 1 .

Ladder Abdil. 1 1 a1 o SIS RS SN S S
Hela ERK1.. 1 2 w2 -
Hela ERK1.. 1 3 A3
Hela ERK1.. 1 4 A4 C4
Hela ERKT.. 1 5 A Y
Hela ERKT.. 1 6 A6 Cf
Hela ERKT.. 1 7 a7 oo
Hela ERKT.. 1 8 a8 cf .
Hela ERK1.. 1 9 a0 o
Hela |ERK1_ |1 10 A C - - - -
Hela ERK1.. 1 1 A cf o
Hela ERKT.. 1 12 A. Cf
Hela ERKT.. 1 13 AL Cf
Hela ERKT.. 1 14 AL Cf
Hela ERKT.. 1 15 AL C
Hela ERK1.. 1 16 AL C
Hela ERK1.. 1 17 AL C
Hela ERKT.. 1 18 AL C

11) B f R &

o, #F LA R, HICopy, #FCopy, H

AFED, BEHENHRERX, KESave FHE R ZHFAEERE
By 7 o

Copy Gel

(®) PNG Format
JPG Format
(C)BMP Format

Save... Cancel




E

1)

2)
3)
4)
5)
6)
7)
8)
9)

simple

EEW
RAEH S EREREH, BERANEERFEB-24C, WEF/

NABRHIAZFEIRIAK, FEE8-24 CHE 24 NH BT RIEA,
E R S B

& J |H 4, %% By Standard pack, Ladder 4o fn e S — #2748 4 ;

A BB AT AR, A EA R R TR R B
WRpEREFEYE, FHom ERE, WRDEXK;
a0 FIREE, T REBN;

TR T 50 HF N

R B O ALIE 7 A

T AR b oy B A A LR B T el A 3T, W AR
THEFR T KB, FI2EZEM;

10) ¥ % LIk 1, % 0, «Size Assay Development Guide.pdf» ;
11) f# Jf 2-40kDiR | &, Compass# 1 sb M I+ K E|v3.o AR B A L ;
12) Compass 3 1~ IRl % %, s BT HCFT A M3k T 4K

http://www.proteinsimple.com/compass/downloads/

13) AR A AL AT P, P B A BATEYBOR LFF, 34K 4T 4000-863-973.


http://www.proteinsimple.com/compass/downloads/

7. & W] A

AR BN f Ty
5L 45 R 5 %R B CF | | Wes £ B £ ALEY B R | BIAWes L T F ALK A,
EATHER X (runfile) | BWrJF 1T JF Compass#h 1, #IA
& HWes, & fInstrument
>Runs..., EHIHHF O
V\Jﬁ@ﬂiﬁ ER XM, &
#+Save At} 7
" R Wes 18 F & & 7£ % B % | Wes ] T F E & LI i
;;@#Wﬁé&%%% %, BRI RAURN | 28 (18-24°C) KE
H E Dog/NHULE

FEAEERE LW

RENB R EERE FH it., Standard Pack 1% 12-
7R 5 ’
T4 BRTERTAEAS 230kD, Standard Pack 2%
66-440kD
BT LA RABE . M ig;fgﬁgkﬁgﬁ
RANERHTDAE | FEBHUETAELH S
o Ja BB A AR, &AMk

1 B

%tw% HANT E WY,
RERH*—F2H

Wes # F # A 8 2 A %
w, AR A AT

Wes ¥ F E & L b HF 44
WER (18-24°C) % &
Z Doy E

Graph View % 3.2 %& & 4
FEME A M

L3 R L1 5 X

o 154 oy R OL B ) (e
5s) EELER. TR H
&K E

MFEAAGETEEAET
IR M

T AR I 0y L 5 B

3t R AR B e
I A M b TR T IR

hERETELNE

THT%E

i 1 R A T
EH TG HER

Total Protein & 7| & # %
NEEMZE

Biotin Labeling Reagent %
ArRAER

Biotin Labeling Reagent &
T | %

Reconstitution Agent 1 fn
Reconstitution Agent 2 g
G RELETRIT6
PRAE 7548 4

7 EHLAT 30 250 A HL &
Biotin Labeling Reagent

- 10 %,
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T H ht 5
Anti-Rabbit Detection Module for Wes, Peggy Sue or Sally Sue DM-o001
Anti-Mouse Detection Module for Wes, Peggy Sue or Sally Sue DM-002
No secondary Detection Module for Wes, Peggy Sue or Sally Sue DM-o003
Biotin Detection Module for Wes, Peggy Sue or Sally Sue DM-o004
Anti-Human IgG Detection Module for Wes, Peggy Sue or Sally Sue DM-o05
Anti-Goat Detection Module for Wes, Peggy Sue or Sally Sue DM-006
Total Protein Detection Module for Wes, Peggy Sue or Sally Sue DM-TPo1
12-230kDa Wes Separation Module 8x25 capillary cartridges SM-Wooy4
12-230kDa Wes Separation Module 8xa13 capillary cartridges SM-Woo2
66-440kDa Wes Separation Module 8x25 capillary cartridges SM-Wo08
66-440kDa Wes Separation Module 8xa3 capillary cartridges SM-Woo6
2-40kDa Wes Separation Module 8x25 capillary cartridges SM-Wo12
2-40kDa Wes Separation Module 8xa3 capillary cartridges SM-Woz1o0
Wes 12-230 kDa Total Protein Master Kit with Split Buffer for 104 data points PS-TPog
Fluorescent sXMaster Mix 1 (12-230kD) PS-FLo1-8
Fluorescent sXMaster Mix 3 (66-440kD) PS-FLo3-8
Fluorescent sXMaster Mix 5 (2-40kD) PS-FLo5-8
10xSystem Control Primary Antibody - Rabbit 042-196
10xSystem Control Primary Antibody - Mouse 042-191
Streptavidin - HRP 042-414
Chemiluminescent Substrate PS-CSo1
Anti-Rabbit Secondary Antibody 042-206
Anti-Mouse Secondary Antibody 042-205
20X Anti-rabbit HRP Conjugate 043-426
Milk-free Antibody Diluent 043-524
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NP1ooo # i & & B 171t KH# % -F &

FEG®:

FIR & a & BmE (it WEfERrH#T0H,
AR EaENAN TR EEEam B Mt E, 7
BT AN E W RWESRAELELFHERY FE
(BT L,EES) , ATEARG % FEEME
EAE .

BABA® S
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